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Executive Summary 
The Burrup Peninsula rock art is widely recognised as a unique example of human 

achievement, with many hundreds of thousands of petroglyphs representing 

perhaps 40,000 years of art, nature and human history.  The development of 

industries in the vicinity, including the Woodside LPG facility, the Yara Ammonia 

Manufacturing Plant and the Yara Technical Ammonium Nitrate Production Plant, 

has raised natural concerns for the rock art preservation.  Since 2004, a monitoring 

program has visited a sample of sites on the Peninsula annually, collecting 

quantitative measurements on their condition. 

Initially (up to 2016) this work was conducted by the CSIRO.  In 2017, Yara organised 

for a similar data collection at the sites in proximity to their plants.  To ensure as high 

a level of consistency as possible, the Yara work used the same instruments as had 

been used by the CSIRO and followed the same methodology.  This report analyses 

the Yara data in conjunction with the CSIRO data. 

The Yara 2017 data collection did not include the control sites (1 and 2) in the 

northern part of the Peninsula.  This omission necessitated a change to the statistical 

analysis, to fit trend models so that the 2017 Yara data could effectively be compared 

with what the 2017 control would have been if it had been collected.  This change in 

approach, in conjunction with the additional data, had the potential to increase the 

statistical power of the analysis. 

Data preparation included: 

• Ensuring that the processing steps such as the transformation to (L*,a*,b*) colour 

co-ordinates and the extraction of spectral features matched the procedures used 

by the CSIRO. 

• The removal of obviously erroneous data points. 

The statistical analysis used linear mixed models, a methodology that is able to allow 

for the natural variation introduced by the sampling of sites and of spots within sites 

to be measured.  This approach was discussed in earlier Data Analysis Australia 

reports and adopted in the most recent CSIRO report.  It is important to understand 

the full structure of this variation to achieve accurate statistical inferences, so it was 

examined in some detail.  It was discovered that: 

• There was some evidence that each year the workers had difficulty in returning 

to precisely the same spots at each site, presumably due to restrictions on 

marking the engravings themselves. Consequently the year-to-year variation was 

substantially greater than the within year variation, reducing the benefit of the 

replicate measurements made each year.  Future monitoring plans should reduce 

the replication at each spot each year (and by so doing reduce the risk of damage) 

and the effort be redirected towards additional sites. 

• The analysis of spectral absorption band data indicated that rock type was 

potentially a significant issue.  The two rock types – gabbro and granophyre – 

appear to have significant differences when measured by the ASD instrument.  
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For that reason, rock type was introduced into the analysis despite the limitation 

that the control sites consisted of only one of each rock type. 

The statistical analyses focused on the interaction of three factors – control versus 

industry sites, engraving versus adjacent background points on the rock, and time.  

In essence, the question was whether the contrast between the engravings and their 

background changed over time differently for control and industry sites. 

The colour measurements with the KM and ASD instruments suggested colour 

changes may have taken place over the monitoring period at a different rate for the 

control and industry sites.  However the two instruments do not identify a common 

structure to this possible change, casting some doubt on its true significance.  In 

addition, the dependence of this finding on apparent changes in recent years at just 

one site (Site 2) lessens the weight that can be attached to it. 

The analysis of the ASD spectral line data also suggests some changes may have 

taken place.  Again, the pattern in this is less than clear and the finding relies heavily 

upon the two control sites. 

This investigation has highlighted the limitations of the existing monitoring design 

which prevents more definitive findings.  However the monitoring program has 

provided valuable information for an improved design. 
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1. Introduction 
The Burrup Peninsula rock art is widely recognised as a unique example of human 

achievement, with many hundreds of thousands of petroglyphs representing 

perhaps 40,000 years of art, nature and human history.1  The development of 

industries in the vicinity, including the Woodside LPG facility, the Yara Ammonia 

Manufacturing Plant and the Yara Technical Ammonium Nitrate Production Plant, 

has raised natural concerns for the rock art preservation.  Since 2004, a monitoring 

program has visited a sample of sites on the Peninsula, annually collecting 

quantitative measurements on their condition. 

Initially (up to 2016) this work was conducted by the CSIRO.  In 2017, Yara organised 

for a similar data collection at the sites in proximity to their plants.  To ensure as high 

a level of consistency as possible, the Yara work used the same instruments as had 

been used by the CSIRO and followed the same methodology. 

1.1 Previous studies 
Data Analysis Australia has conducted reviews of the data in 20162 and 20173 

following concerns about the monitoring process.  These reviews highlighted several 

statistical issues: 

• Linear mixed models (or random effect models) were identified as the most 

appropriate statistical approach, but were not conducted in the CSIRO reports4.  

This was originally suggested by John Black and Simon Diffey5. 

• The analysis focused on a Before-After Control-Intervention (BACI) principle, 

assessing how the difference between the control and industry related sites 

changed over time.  The main variable being measured was the difference or 

contrast between the engraved areas of petroglyphs and their background.  

Hence this can be considered a three way interaction – time, sites and whether 

the engraving or background is measured. 

                                                      

1 The petroglyphs are difficult to age but it has been suggested that they could survive for up to 60,000 

years (Brad Pillans, L. Keith Fifield, Erosion rates and weathering history of rock surfaces associated 

with Aboriginal rock art engravings (petroglyphs) on Burrup Peninsula, Western Australia, from 

cosmogenic nuclide measurements, Quaternary Science Reviews 69, 98-106). 

2 Data Analysis Australia, Henstridge et al, 2016, Review of Statistical Aspects of Burrup Peninsula Rock 

Art Monitoring,  (Reference DER/1). 

3 Data Analysis Australia, Henstridge et al, 2017, Review of CSIRO Report on Burrup Peninsula Rock 

Art Monitoring,  (Reference DER/2). 

4 Each of the CSIRO reports covers the data over a period from 2004 and is generally published in the 

year following the latest data.  The most recent report was from 2017, with data up to and including 

2016. 

5 Black, J and Diffey, S., 2016, Reanalysis of the Colour and Minerology Changes from 2004 to 2014 on 

Burrup Peninsula Rock Art Sites, unpublished.  
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• The design focused on replicated measurements (often 20 or more) at a limited 

number of points at a limited number of sites.  Almost surely it would have been 

more effective to have less replication but many more sites.  This would have 

reduced concerns about damage to specific sites and would have given the 

opportunity to better understand the effect of different rock types. 

• The analyses of the (L*,a*,b*) data indicated that the original spectrophotometer 

instrument (the BYK brand) was not reliable.  We understood that there were 

problems with the instrument itself and also suggestions that the data was not 

well managed through the process of cross-calibrating to a newer Konica Minolta 

(KM) spectrophotometer.  We recommended that the BYK data be ignored in any 

assessment unless a better understanding of how it was used leads to renewed 

confidence in its data.  This has the unfortunate effect of limiting the 

spectrophotometer measurements to starting in 2009, when the KM instrument 

was introduced. 

• The Analytical Spectral Devices (ASD) spectrometer was used throughout the 

study period.  While its principal advantage is its recording of near infrared 

(NIR) reflectance spectra, it also recorded in the visible spectrum, and could 

therefore give colour estimates. 

• Substantial apparent variation was discovered in the reproducibility of 

measurements made at particular points6 with the ASD instrument.  This 

suggested that there may have been variation in the procedures used from year 

to year.  There are at least two possible approaches to how replicated 

measurements can be taken at each point: 

○ One approach is to return to and record at a single point each year, using 

photographs of the points on each petroglyph as a guide.  In this case the 

replicated measurements represent independent attempts to record at the 

“correct” point.  An extreme form of this approach is to leave the instrument 

in place on the rock surface between replicate measurements. 

○ A second approach is that the repeated measurements are an opportunity to 

broaden the area being measured around each point.  In this case the 

measurements attempt to cover a small area around each central point, to 

avoid issues that arise if the exact same point location was not measured from 

year to year. 

                                                      
6 At each site, measurements were taken at a number of spots.  The numbering or labelling of the spots 

was only meaningful within each site – the first spot of one site was not linked to the first spot at 

another site. 

Each spot was, somewhat confusingly, made up of two measurement points, one which was on the 

engraving at that site and one that was close by but not on the engraving, that is, on the background.  

(The CSIRO Report did not use the terminology of a point, but we do so here to reduce ambiguity.)  

These points were defined when the monitoring at each site was first done and ideally the 

measurements should attempt to measure at exactly the same points every year, no simple task since it 

is not appropriate to mark the rocks in any way. 
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Each of these approaches has some validity and the choice should be based upon 

small scale spatial variation typically encountered in the petroglyphs.  The CSIRO 

reports indicate that the former approach was used but there are some 

suggestions that a change to the second approach was adopted in later years7.  

The data itself suggests a more complex set of changes.  

• The CSIRO reports referenced other factors that may affect the data, most notably 

the two major rock types found on the selected sites – gabbro and granophyre.  

The design of the monitoring with a small number of sites limited the inclusion of 

such factors in the analysis. 

1.2 Measuring Reflected Light 
All the measurements considered in this report are of light reflected off the 

petroglyph surface.  This is interpreted in two ways: 

• The colour of the reflected light; and 

• The spectrum of the reflected light (or infrared). 

In both cases there are a number of issues in just how the measurement is made, 

relating to the angle of the illumination and the angle of the reflected light.  It is 

beyond the scope of this report to explore these in detail but the complexity of this, 

particularly when the surface is not smooth, is such that to be of any value in 

measuring change it is essential that the methods used are absolutely consistent – 

ideally the same instrument calibrated in the same way and used in the same 

manner. 

1.2.1 Measuring Colour 

Colour measurement is intrinsically related to how the human eye perceives light.  

The three types of cone – the colour sensing cells in the human retina – lead to the 

natural step of measuring light in three dimensions.  Just what these three 

dimensions are is a matter of choice, depending upon context and convention.  For 

example, in photography it is common to measure the intensity in “red”, “green” 

and “blue”, leading to the RGB system. 

In many contexts it is appropriate to separate out the overall intensity as one 

dimension and to have the other two dimensions independent of this overall 

intensity.  This report uses one such system, (L*,a*,b*), where L* represents the 

overall intensity and a* and b* represent colour.  This is a non-linear transformation 

of the basic intensities developed to match human perception – that is, a difference in 

(L*,a*,b*) of a certain size in any part of the colour space will have a similar 

likelihood of being perceived as “different”. 

In the case of reflected light from a surface, it is also necessary to consider the light 

illuminating the surface.  Standard illuminants have been defined.  The CSIRO 

appear to have standardised on the D65 illuminant, corresponding to daylight. 

                                                      
7 Ian McLeod, formerly of the WA Museum, personal communication. 
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1.2.2 Measuring Spectra 

Measuring the spectrum means considering a single wavelength of light at a time.  

This avoids many of the compromises involved in low dimensional measures of 

colour and in the case of reflectance it avoids the issue of which illuminant was used.  

The problem is that the spectrum must be considered at many wavelengths.  

Spectroscopy usually focuses on wavelengths associated with particular chemical 

elements or compounds.   

The CSIRO work focused on several spectral absorption bands (or lines) in the near 

infrared: 

• The depth of the spectral absorption band at 900 nm (D900), associated with iron 

oxides;  

• The minimum wavelength associated with the spectral band at 900 nm (W900); 

• The depth of the chlorite absorption band at 2250 nm; 

• The depth of the kaolinite absorption band at 2206 nm; and 

• The depth of the gibbsite absorption bands at 2267 nm (secondary minerals 

resulting from the weathering of the primary minerals). 

In each case the absorption was measured by comparing the reflectance at the 

wavelength of the band against a value interpolated from the adjacent wavelength in 

the spectrum.   

The CSIRO work used the proprietary program The Spectral Geologist (TSG)8 to 

process the spectra to derive “parameters” and colour values for data from the ASD 

instrument.  In this study we have, for consistency, used the same software with the 

same configuration.  Whilst we have no reason to believe that TSG is not performing 

this task well, it remains a “black box” in terms of its precise algorithms. 

1.3 Linear Mixed Models 
At this point it is necessary to introduce some notation for representing models used 

in the report.  If we have factors that we might term A and B which we are trying to 

use to explain the variation in a measurement y (say the reflectance), we could have a 

number of possible models that by convention we write as y ~ expression.  The 

possible models are: 

y ~ 1 y does not depend upon either A or B; 

y ~ A y depends only on A; 

y ~ B y depends only on B; 

y ~ A + B y depends only on both A and B but they act independently 

of each other; and 

                                                      
8 https://research.csiro.au/thespectralgeologist/ 
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y ~ A * B y depends only on both A and B and each of A and B 

affects the way that y depends upon the other.  This model 

can also be written as y ~ A + B + A.B where the A.B term 

makes the inclusion of the interaction between A and B 

explicit. 

This notation generalises to more factors in the obvious manner and allows for 

complex model choices. 

There are at least three factors or variables of immediate concern: 

• engraving – the difference between an engraving and its background which is 

what makes the engravings visible – that is, the contrast of the engraving with its 

background.  This is referred to as the type variable in the analysis; 

• control – the difference between the northern control sites and the southern sites 

close to industry development.  This is referred to as the CI (Control-Industry) 

variable in the analysis; and 

• time – recognising that measurements may change over time, thought of as either 

the year or the trend over the years.  In the analysis, this is referred to as the 

YearF variable when considering the year itself, and as a quadratic trend when 

considering the trend over years. 

The measurement (y) could be any of the �∗, �∗, �∗ components measured with any 

instrument, or any of the spectral absorption bands measured on the ASD.  In 

practice the model will also have additional terms, some of which are treated as 

random, to provide the most appropriate analysis. 

The more relevant term in the model is the three-factor interaction 

engraving.control.time that measures the degree to which change in the contrast over 

time is different between the control and potentially affected areas.   

1.4 Study Design and the 2017 Data 
While the original monitoring design was not ideal, it did follow basic principles of 

experimental design in that in each year both industry affected sites and the control 

sites were measured, until 2016.  This ensured that any year specific measurement 

factors could be corrected for, essentially by assuming that the control sites should 

remain unchanged.  The analysis method required the control data for this purpose. 

In 2017, only the Yara related industry sites were measured, with no control sites.9  

This necessitates changes to the analysis method to utilise the 2017 data.  This 

required making the assumption that the year specific effects would take the form of 

a trend, allowing the trend estimated for the industry sites using data including 2017 

to be compared against the trend estimated for the control sites using data up to 

                                                      
9 We understand that Yara were only required to measure the sites in the vicinity of their plant and 

there may have been access issues for the control sites. 
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2016.  In adopting this assumption, Data Analysis Australia examined the data to 

ensure that it was reasonable.   

In the analysis presented in this report, we were cognisant of the importance of the 

Yara plants and the changes that have taken place over the period of the monitoring.  

For that reason it was considered appropriate to use a quadratic trend model, to 

allow not only for changes, but also for possible increasing or decreasing rates of 

change. 

Upon closer examination, the 2004 ASD data was considered systematically different 

from the data from 2005 onwards.  It is not uncommon for the first year of data 

collection to be different in a context such as this, with refinements and lessons 

learned being implemented for the second year, so this should not be considered as a 

criticism.  With the previous year’s analyses considering each year separately, rather 

than as a trend, the statistical models could handle this appropriately.  With the shift 

to a trend model, it is inappropriate to retain such data, and all 2004 data has been 

removed from this year’s analysis. 

This trend based approach to analysis is particularly effective as the length of the 

monitoring period increases – the statistical power with respect to estimating trends 

increases substantially with each addition year of data. 

2. Data 
2017 data from two instruments were provided to Data Analysis Australia, the 

Konica Minolta (KM), and Analytical Spectral Devices (ASD), for each replicate for 

each point.  BYK data was not received nor used in any analysis. 

The received data corresponded to recordings from November 2017 across sites 5, 6, 

7, 21, 22, and 23 as described in the CSIRO report10. 

Data Analysis Australia appended the 2017 data to the data prepared by CSIRO up 

to and including 2016, which had been made available to Data Analysis Australia 

when conducting our earlier reviews.  Note that the data made available to Data 

Analysis Australia up to and including 2016 was for each replicate of each point for 

the L*, a* and b* values (for both the KM and ASD data), but was only at an average 

level for each point for the other spectral line data.  Data Analysis Australia 

appended the data at these same levels. 

An illustration of the nature of the ASD spectra is provided in Appendix A, 

including the spectrum of the one errant spectrum removed from the dataset. 

                                                      
10CSIRO (2017), Burrup Peninsula Aboriginal Petroglyphs: Colour Change & Spectral Mineralogy 2004-2016. 
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Figure 1 and Figure 2 below show the locations of the petroglyph monitoring sites 

around the Yara Plant and the location of these sites relative to the control sites, 

respectively.  Inside each site, there were 4 spots inspected, with each spot consisting 

of an ‘engraving’ and ‘background’ pair of points.  Approximately 20 placements 

occurred for each combination of site, spot, and type. 

 

 

Figure 1.  Petroglyph sites around Yara Plant.  (Image sourced from CSIRO Report 2017).   
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Figure 2.  Location of ‘industry’ sites (southern) in relation to the Control sites (northern).  

Note that this map does not include the new Yara monitoring sites, but they are in the 

same vicinity as the other industry sites.  (Image sourced from CSIRO Report 2017). 
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2.1 Konica Minolta Data 
The KM spectrophotometer data supplied to Data Analysis Australia totalled 1,029 

observations across the six sites.  Each data point provided a value for the L*, a*, and 

b* measurements along with a unique identifier for the site, spot, type, and sample 

number.  Six of the data records had text identifiers specifying that they should be 

ignored in the analysis, and hence they were excluded.  Of the remaining 1023 

observations, nine identifiers were blank; however, based on the structure of the file 

and other QA checks, these could be assigned identifiers based on the records 

surrounding the blank observations.  Hence, they were retained in the analysis.   

The 2017 data was added to historical data using the KM instrument, resulting in a 

final data set of 11,323 observations from 2009-2017. 

2.1.1 Box Plots of KM Data Values for all sites 

The following set of figures (Figure 3 to Figure 5) show boxplots11 of the L*, a* and b* 

KM data values respectively, for all sites included in the monitoring.  The different 

colours in the boxplots represent the CI variable (Control or Industry) and the type 

variable (background or engraving).  This allows for visual identification of trends or 

discrepancies for each combination of these over time12.   

The width of each box plot represents the amount of data available for each 

combination of year, CI variable and type – the wider the box, the more data there 

was, and as can be seen, there is no control data for 2017. 

                                                      
11 Box plots are commonly used in statistics to display the spread and symmetry of a data set.  The box 

represents the middle half of the data, extending from the lower quartile (25% of data points are below 

this value) to the upper quartile (25% of data points are above this value).  The horizontal line within 

the box indicates the median (middle value). 

Two vertical lines, called whiskers, extend above and below the box, typically to the smallest and 

largest values in the data.  More extreme values, either higher or lower, are plotted individually 

beyond the whiskers.  For the plots in this report, the extreme values are defined as any value that is 

more than 1.5 times the interquartile range (the distance between the lower quartile and upper 

quartile) away from the box.  The width of the box is proportional to the number of observations 

represented. 

12 Boxplots for each variable individually are provided in Appendix B. 
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Figure 3. Box plot for the KM L* by Type:CI:yearF for all sites. 

 

Figure 4.  Box plot for the KM a* by Type:CI:yearF for all sites. 
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Figure 5.  Box plot for the KM b* by Type:CI:yearF for all sites. 

2.1.2 Box Plots of KM Data Values for Yara and Control Sites Only 

The following figures (Figure 6 to Figure 8) are analogous to those in the previous 

section, but are restricted to the Yara and Control sites only.   
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Figure 6.  Box plot for the KM L* by Type:CI:yearF for Yara sites and control sites. 

 

Figure 7.  Box plot for the KM a* by Type:CI:yearF for Yara sites and control sites. 
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Figure 8.  Box plot for the KM b* by Type:CI:yearF for Yara sites and control sites. 

2.2 ASD Data 
The format of the ASD data provided was that of reflectance spectra for 1,149 

observations in 2017 following the removal of practice and testing placements.  The 

discrepancy between the number of KM and ASD observations was due to 

approximately two or three more placements on each combination of site/spot/type 

for the ASD instrument. 

The conversion of ASD reflectance data to (L*,a*,b*) and the extraction of the spectral 

line parameters was performed using The Spectral Geologist (TSG) program, Version 

8.0.  Assistance was provided by Erick Ramanaidou of the CSIRO in ensuring that 

the settings in TSG were the same as used for previous years of data.  In all cases the 

methods were tested on 2016 reflectance data to ensure the values matched those 

previously supplied by the CSIRO.  These details are given in Appendix F.   

As referenced at the commencement of Section 2, the 2017 ASD (L*,a*,b*) data 

processed by Data Analysis Australia was appended to the CSIRO provided data for 

previous years for analysis at a replicate level for each point, and the spectral line data 

at the average level for each point.   

Data Analysis Australia extracted the 2017 spectral line information by applying the 

TSG program to each spectrum and then averaging.  The results were then appended 

to similarly calculated data from previous years. 

It is appropriate to make some comments on the use of the TSG program: 

• It is a proprietary program with the details of algorithms not available for 
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there was concern it would be necessary to re-implement the algorithms in a 

different system. 

• Like all software, TSG undergoes version changes.  When using it in the future it 

would be necessary to ensure that changes have not been made to critical 

algorithms. 

• TSG does not appear to have a scripting language and has a number of settings 

that must be interactively chosen by the user.  This increases the difficulty in 

obtaining consistent results. 

Overall, the continued use of the TSG program must be questioned. 

2.2.1 Box Plots of ASD Colour Data for all sites 

The following set of figures (Figure 9 to Figure 11) show boxplots of the L*, a* and b* 

ASD data values respectively, for all sites included in the monitoring13.  As with the 

KM data boxplots presented in Section 2.1.1, the different colours in the boxplots 

represent the CI variable (Control or Industry) and the type variable (background or 

engraving).  This allows for visual identification of trends or discrepancies for each 

combination of these over time14.   

The width of each box plot represents the amount of data available for each 

combination of year, CI variable and type – the wider the box, the more data there 

was, and as can be seen, there is no control data for 2017. 

                                                      
13 Note that 2004 data is included in these plots, despite being excluded from all analyses and from all 

similar plots that don’t display each year separately.  Its inclusion in this particular set of plots is 

considered appropriate as it (a) demonstrates the differences between the 2004 data and all subsequent 

data, hence justifying its exclusion from the analysis, and (b) does not impact on any other data in the 

plot, because this year’s data is being displayed separately. 

14 Boxplots for each variable individually are provided in Appendix C0. 
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Figure 9.  Box plot for the ASD L* by Type:CI:yearF for all sites. 

 

Figure 10.  Box plot for the ASD a* by Type:CI:yearF for all sites. 
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Figure 11.  Box plot for the ASD b* by Type:CI:yearF for all sites. 

2.2.2 Box Plots of ASD Colour Data for Yara and Control Sites Only 

The following figures (Figure 12 to Figure 14) are analogous to those in the previous 

section, but are restricted to the Yara and Control sites only.   

 

Figure 12.  Box plot for the ASD L* by Type:CI:yearF for Yara sites and control sites. 
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Figure 13.  Box plot for the ASD a* by Type:CI:yearF for Yara sites and control sites. 

 

Figure 14.  Box plot for the ASD b* by Type:CI:yearF for Yara sites and control sites. 

2.2.3 Box Plots of ASD Spectral Line Data Values for all sites 

The following set of figures (Figure 15 to Figure 19) show boxplots of the average 

ASD spectral line data values, for all sites included in the monitoring.  The different 
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colours in the boxplots represent the CI variable (Control or Industry) and the type 

variable (background or engraving).  This allows for visual identification of trends or 

discrepancies for each combination of these over time.   

The width of each box plot represents the amount of data available for each 

combination of year, CI variable and type – the wider the box, the more data there 

was, and as can be seen, there is no control data for 2017. 

 

Figure 15.  Box plot for the depth at 900 nm by Type:CI:yearF for all sites. 
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Figure 16.  Box plot for the minimum of wave length by Type:CI:yearF for all sites. 

 

Figure 17.  Box plot for the depth of chlorite by Type:CI:yearF for all sites. 
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Figure 18.  Box plot for the depth of gibbsite by Type:CI:yearF for all sites. 

 

Figure 19.  Box plot for the depth of kaolinite by Type:CI:yearF for all sites. 
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2.2.4 Box Plots of ASD Spectral Line Data Values for Yara and Control 
Sites Only 

The following figures (Figure 20 to Figure 24) are analogous to those in the previous 

section, but are restricted to the Yara and Control sites only.   

 

Figure 20.  Box plot for the depth at 900 nm by Type:CI:yearF for Yara sites and control 

sites. 
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Figure 21.  Box plot for the minimum wave length by Type:CI:yearF for Yara sites and 

control sites. 

 

Figure 22.  Box plot for the depth of chlorite by Type:CI:yearF for Yara sites and control 

sites. 
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Figure 23.  Box plot for the depth of gibbsite by Type:CI:yearF for Yara sites and control 

sites. 

 

Figure 24.  Box plot for the depth of kaolinite by Type:CI:yearF for Yara sites and control 

sites. 
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3. Modelling of Colour Data 
Data Analysis Australia carried out a number of analyses for variables �∗, �∗ and �∗.  

Since the data for control sites (sites 1 and 2) were not available in 2017, a trend 

model was used to determine whether the trend remains unchanged over the years.  

Linear mixed effects models were fitted, including random effects to take into 

account variation between sites, between spots on a site and between times for each 

spot.  In the investigation of what would be the most appropriate models, several 

observations were made: 

• We had anticipated that the random effects component – essentially the structure 

of measurement errors – would have a ”spots within sites” aspect and a year-to-

year component represented by the model formula sites/spots+years.  This 

reflected that sites were chosen at random but thereafter kept constant, and 

within each site, spots were also chosen at random and then kept constant, but 

that there was no correspondence between spots at different sites.  The year 

component was thought necessary to allow for subtle changes in methodology 

and observation conditions. 

• It became apparent that the random component had an additional aspect, the 

variation from year to year at each spot, leading to the model formula 

sites/spots/years+years.  This strongly suggests that in each year the fieldworkers 

had difficulty in identifying the precise points on the rock surface to be 

measured.  That is, each year, the workers attempted to identify a “correct” point 

and aimed their repeated measurements at that point, but the point varied from 

year to year.  This effect was substantially greater than any systematic variation 

from year to year, suggesting that the fieldworkers were consistently 

implementing a flawed methodology – it seems virtually impossible to ensure the 

precise point is being “found” every year. 

• The analysis method we used could readily adapt to this observation, but it does 

have implications for future planning. 

• In parallel to this modelling we also examined the NIR spectral line data.  This 

data made it apparent that rock type – Gidley gabbro (sites 1, 7, 22, and 23) 

versus Gidley granophyre (2, 4, 5, 6, 8, and 21)15 – could be more significant than 

previously thought.  Hence this was introduced as a factor in the models, despite 

our reservations on the small number of sites for each rock type.   

• It was also thought appropriate to include analyses that were restricted to the 

sites around the Yara plant and were measured in 2017.  This restored a 

semblance of statistical balance (the control sites were still missing in 2017) and 

gave the possibility of giving findings more relevant to Yara. 

• Given the number of variables, the key step was to consider overall significance 

of the interaction control:type:time.  A simple likelihood ratio test was used to 

compare a full model that includes this three way interaction (and interactions 

                                                      
15 CSIRO (2014). Burrup Peninsula Aboriginal Petroglyphs: Colour Change & Spectral Mineralogy 2004-2014. 
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that include it) with a reduced model that does not.  It is a standard statistics 

result that twice the logarithm of the ratio of the likelihoods for these two models 

will have a chi squared distribution with degrees of freedom corresponding to 

the differences in the models.  A likelihood ratio greater than a critical value 

derived from the chi squared distribution is indicative of statistical significance.  

(The significance of rock type made this step slightly more complex, with the 

need to consider both this three way interaction and the four way interaction that 

also included rock type.)  

• The analysis was performed in the statistical program R16, using the function 

lmer.  The maximum likelihood approach was used so that models could be 

validly compared using the likelihood ratio statistic.  The calculated values of this 

statistic were compared against the chi-squared distribution which is known to 

be asymptotically appropriate. 

These observations largely applied to the analysis of the spectral line data as well.  

The key difference was that the spectral line data were based on average spectra at 

each point rather than the individual replicated spectral measurements.   

Summary plots of the colour data for the KM and ASD instruments are presented in 

Appendix E. 

3.1 KM Colour Data 
The results of the test of statistical significance are given in Table 1 and Table 2 

below, considering models without and with rock type as a factor respectively17.  

Note however that the overall effect of rock type is statistically significant and hence 

the primary reference should be Table 2, with Table 1 being provided for comparison 

with previous reports.   

From Table 2, it can be seen that the changes in the colour measures a* and b* appear 

to be statistically significant, with L* being close to statistically significant, with little 

difference between whether the analysis uses the full data or just the Yara specific 

data. 

Table 1.  Chi square statistics for the test on whether there is a significant three way 

interaction control:type:time with the KM data.  These correspond to the models without 

rock type included.  The critical value (at the 5% level) for the test is 5.99 based upon 2 

degrees of freedom. 

 Chi square 

 Full Data Yara Sites 

L* 0.38 0.76 

a* 0.31 0.16 

b* 3.23 0.67 

                                                      
16 R Core Team (2018). R: A language and environment for statistical computing. R  Foundation for Statistical 

Computing, Vienna, Austria. URL  https://www.R-project.org/. 

17 The relevant model details are provided in Appendix G.1. 
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Table 2.  Chi square statistics for the test on whether there is a significant three way 

interaction control:type:time with the KM data.  These correspond to the models with rock 

type included.  The critical value (at the 5% level) for the test is 9.49 based upon 4 degrees 

of freedom. 

 Chi square 

 Full Data Yara Sites 

L* 8.15 8.58 

a* 17.50 17.95 

b* 16.61 16.12 

Using a* and the full dataset as a demonstrative example, this apparently significant 

interaction is better illustrated in Figure 25, a diagram termed an interaction plot.  

Similarly shaped lines on such a plot indicate that there is no interaction.  Here the 

predicted values for a* are given for the various combinations of engraving versus 

background, control versus industry and gabbro versus granophyre.  (A full set of 

interaction plots is provided in Appendix H.)   

 
Figure 25.  Interaction plot for full KM data, a*.  The engraving effects are in blue, the 

background in red.  The control effects are continuous, the industry dashed.  The 

granophyre effects are heavy lines, the gabbro light. 

The picture presented by this plot is complex, indicating that interpretation is not 

straightforward.  There appear to be several different trends.  An investigation of the 

data behind this suggested that the greatest contribution to the interaction is from the 

granophyre control (Site 2, the heavy continuous lines).  It is unfortunate that this site 

is the only granophyre control site and there is also only one gabbro control site, a 

limitation of the monitoring design dating back to 2004.  Hence care should be taken 

in assuming that the statistical significance has practical significance. 
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3.2 ASD Colour Data 
The analysis of the ASD data followed closely that of the KM data.  In this regard 

there was a significant difference between the analysis presented here and that done 

in Data Analysis Australia’s 2016 and 2017 reports18, namely in the consideration of 

variation in the residual randomness between years.  Our 2017 analysis had 

identified that there were statistically significant differences in the level of 

randomness, suggesting changes in procedures.  The analysis presented in our 2017 

report took this into account.  In the current project this complexity was dropped 

when it was observed that it made almost no effect on the analyses (estimated 

coefficients and significance of effects) while increasing the computational time by a 

factor of about 100.  The faster computation allowed us to explore a greater range of 

models and hence feel more confident about the overall results. 

The results of the test of statistical significance are given in Table 3 and Table 4 

below, considering models without and with rock type as a factor respectively19.  The 

overall effect of rock type is statistically significant and hence the primary reference 

should be Table 4, with Table 3 being provided for comparison with previous 

reports.  In the case of the models without consideration of rock type, the tests fail to 

reach a level of statistical significance.  In the case of the models with rock type 

included, the results for a* and b* appear to be strongly significant and those for L* to 

be close to statistically significant, a result similar to that observed with the KM data. 

Table 3.  Chi square statistics for the test on whether there is a significant three way 

interaction control:type:time with the ASD data.  These correspond to the models without 

rock type included.  The critical value (at the 5% level) for the test is 5.99 based upon 2 

degrees of freedom. 

 Chi square 

 Full Data Yara Sites 

L* 0.38 0.76 

a* 0.311 0.16 

b* 3.22 0.67 

Table 4.  Chi square statistics for the test on whether there is a significant three way 

interaction control:type:time with the ASD data.  These correspond to the models with rock 

type included.  The critical value (at the 5% level) for the test is 9.49 based upon 4 degrees 

of freedom. 

 Chi square 

 Full Data Yara Sites 

L* 8.15 8.58 

a* 17.50 17.96 

b* 16.61 16.12 

                                                      
18 Reports referenced in Section 1.1. 

19 The relevant model details are provided in Appendix G.2. 
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Again the structure of this interaction can be investigated through an interaction 

plot, such as given in Figure 26 for a* and the full data.  (The full set of interaction 

plots is again provided in Appendix H.) 

 

Figure 26.  Interaction plot for full ASD data, a*.  The engraving effects are in blue, the 

background in red.  The control effects are continuous, the industry dashed.  The 

granophyre effects are heavy lines, the gabbro light. 

Again it appears that this result is strongly affected by possibly aberrant data from 

Site 2, although the pattern is not particularly similar to that based on the equivalent 

KM data.  This requires further investigation but is beyond the scope of this report as 

it possibly requires consideration of the differences between the two instruments.20 

4. Modelling of ASD Spectral Line Data 
The initial analysis of the spectral line data was exploratory, particularly since past 

studies had not investigated it in detail.  The five spectral line parameters (as 

specified in Section 1.2.2) were: 

• The depth of the spectral absorption band at 900 nm (D900), associated with iron 

oxides;  

• The minimum wavelength associated with the spectral band at 900 nm (W900); 

• The depth of the chlorite absorption band at 2250 nm; 

• The depth of the kaolinite absorption band at 2206 nm; and 

                                                      
20 Differences that we are aware of include the diameters of the measurement area and the illumination 

system.  In addition, the KM instrument calculates the (L*,a*,b*) values using proprietary algorithms 

that are not necessarily the same as those used in the TSG software. 
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• The depth of the gibbsite absorption bands at 2267 nm (secondary minerals 

resulting from the weathering of the primary minerals). 

The data was based on the average spectrum at each point in each year.  Whilst this 

averaging process means that the measurement to measurement variation is lost, it 

seems appropriate given that the algorithms for extracting out spectral bands are 

non-linear and potentially sensitive to random effects.  The 2016 data as provided 

also had average L*, a* and b* values, and a similar calculation was applied by Data 

Analysis Australia to the 2017 data.  These L*, a* and b* variables were incorporated 

in the spectral line data exploratory analysis discussed below, although the more 

detailed replicate level L*, a* and b* values were used for the formal ASD colour data 

analysis in Section 3.2.  Comparable formal statistical modelling of the five other 

parameters from the spectral line data are provided at the end of this Section.  Two 

outliers were removed from the gibbsite depth analysis. 

It became immediately apparent from the “pairs plots”21 below (Figure 27 and Figure 

28) that the distributions of this data had a number of features 22: 

• The importance of rock type is immediately evident, being most clear in the 

scatter plot of chlorite against gibbsite.   

• It is also suggestive of the chlorite band showing minimal variation amongst the 

granophyre measurements. 

• The relationships appear to be strongly non-linear, although to some extent this 

may be due to the different rock types acting as distinct populations. 

Note that the differences between rock types (gabbro and granophyre) and 

measurement types (engraving and background) are displayed as different colours in 

these plots, to aid with the interpretation. 

                                                      
21 Pairs plots are a set (or matrix) of scatterplots that illustrate the relationship between each pair of 

variables in a dataset.  Each plot in the upper-right portion of the matrix shows the relationship 

between two variables by plotting each data point from the first variable against each data point from 

the second variable.  This allows for any association of the two variables to be seen.  The red lines 

overlaying the scatterplots are loess curves – smoothed regression curves, smoothed by fitting to a 

localised area of the data, to assist with visualising trends in the data.  (The precise details of these red 

lines are not important for this report.)  The linear correlation of each pair of variables is shown in the 

lower-left portion of the matrix.   

22 Additional graphs for each variable individually are provided in Appendix D. 
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Figure 27.  Pairs plot for all sites showing two-way relationships and linear correlations for 

spectral lines and L*, a*, b*.  Note that these L*, a* and b* values are using average spectral 

data, and hence are not the same data used for the colour analysis in Section 3.2. 

 

Figure 28.  Pairs plot for Yara and control sites showing two-way relationships and linear 

correlations for spectral lines and L*, a*, b*.  Note that these L*, a* and b* values are using 

average spectral data, and hence are not the same data used for the colour analysis in 

Section 3.2. 
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In formally analysing this data, various transformations were considered to ensure 

that the distributions of the data might reasonably meet the assumptions of the 

statistical methods.  After investigation, two variables were modified: 

• For the Gibbsite depth, the logarithm was taken; and  

• The chlorite data was restricted to the gabbro sites. 

The results of the tests of statistical significance are given in Table 5 below23.  For 

900nm depth, kaolinite depth, and chlorite depth, a significant four-way interaction 

was found, which says that there is statistical evidence that the impact of Industry 

and Control sites over time is different between background and engraving for the 

two rock types.  For 900nm minimum wavelength and gibbsite depth, there was not 

a significant four-way interaction. 

Table 5. Chi square statistics for the test on whether there is a significant four way 

interaction control:type:rocktype:time with the ASD spectral line data.  The critical value 

(at the 5% level) for the test is 9.49 based upon 4 degrees of freedom, except for the chlorite 

depth where it is 5.99 on 2 degrees of freedom. 

 Chi square 

 Full Data Yara Sites 

900nm Depth 15.00 15.11 

900nm Minimum Wavelength 7.86 6.37 

Kaolinite Depth 14.38 11.98 

Chlorite Depth (only gabbro) 6.50 6.50 

Gibbsite Depth (logged) 2.69 4.51 

Several of these are statistically significant.  The interaction plots are given in 

Appendix H.3 and should be regarded with the same degree of caution 

recommended for the colour analyses in Sections 3.1 and 3.2.  However several 

statistical comments can be made: 

• The statistically significant interaction for the 900nm band depth is strongly 

affected by the industry gabbro sites. 

• The variations in the depth of the kaolinite band, while statistically significant, 

are strongly affected by the granophyre control site (Site 2).  This site has already 

been identified by the colour measurements as being potentially anomalous.   

• The depth of the chlorite band at industry sites appears to be increasing over 

time, bringing it closer to the depth observed at the control site.  (Note that this 

applies only to the gabbro sites.) 

Data Analysis Australia is not able to comment upon the possible geological 

significance of these apparent changes. 

                                                      
23 The relevant model details are provided in Appendix G.3. 
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5. Conclusion 
Data Analysis Australia assembled a dataset that combined the 2017 data collected 

by Yara with the earlier years’ data collected by the CSIRO.  To ensure consistency, 

the 2017 data was processed using the same software – the CSIRO’s The Spectral 

Geologist – before being merged.  To assist future work, the settings used with this 

program are included in an Appendix of this report. 

The analysis of the 2017 data collected by Yara raised a number of statistical issues, 

both in the handling of the data to ensure consistency with past data practices and in 

the analysis itself.  Perhaps the greatest difference was the absence of data for the 

control sites in 2017.  

This made it necessary to use a different approach in the modelling, namely the 

consideration of trends.  While there is a degree of choice in just how trends are 

considered, after consideration of piecewise linear approaches the decision was made 

to use a quadratic trend.  This allowed the full use of the information in the 2017 

data, as well as giving some information on when changes may have been taking 

place through examination of the interaction plots. 

The use of trend models meant that the 2004 ASD data had to be excluded due to 

inconsistency with following years.  This also suggests that 2005 should be 

considered the “base year” in any future work. 

In interpreting the results, in must be remembered that “the absence of evidence is 

not evidence of absence”.  If the monitoring does not show statistically significant 

change then it is appropriate to say that either “the data is consistent with no 

change” or that “if a change has occurred, it is below the level detectable by the 

monitoring program”. 

Key findings are that: 

• The reservations Data Analysis Australia expressed in earlier reports about the 

design of the monitoring have been confirmed.  This includes the number of sites 

monitored, particularly control sites, being inadequate, the difficulty in reliably 

measuring at the same spots year after year and effort wasted with too many 

replicate measurements. 

○ Having only two control sites was highlighted as a problem in the analysis 

this year when it became apparent that rock type was statistically important – 

this means that for each rock type there is only a single control site.  This will 

always throw doubt on the results. 

○ There are strong statistical indications that the task of accurately identifying a 

“spot” (actually a pair of points, one in the engraving and one the nearby 

background) to be measured is impossible to do consistently from year to 

year.  Either the method of precisely locating the measurement points needs 

to be substantially improved or the size of each point being measured needs 

to be increased so that the effect of misplacement of the instrument is 

reduced.  It is possible that this has implications for the choice of instrument. 
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○ The high number of replicates measured at each spot is largely wasted effort 

since the repeat measures each year essentially repeat that year’s errors.  

Given that there is concern about the possible damage being done by the 

measurement process, it seems appropriate to reduce the number of replicates 

from around 20 to (say) 5. 

• Whilst the design of the monitoring is far from ideal, the absence of control site 

measurements in 2017 is unfortunate, and goes against both the intention of the 

original design and normal statistical best practice.   

• The analysis of the ASD spectral line data highlighted the possible impact of rock 

type (gabbro versus granophyre) on all measurements.  This year our analysis 

included rock type, initially in exploratory modelling, and this indicated that it 

has an effect on colour measurements as well.  Previous analyses have not 

considered this. 

• Both the KM and ASD instruments suggested colour changes may have taken 

place over the monitoring period at a different rate for the control and industry 

sites.  However the two instruments do not identify a common structure to this 

possible change, casting some doubt on its true significance.   

○ The lack of sufficient control sites also weakens the weight that can be given 

to this result. 

○ The colour changes recorded by the ASD instrument appear to be 

significantly affected by the last few years’ measurements at Site 2 – 

unfortunately this is a control site so the effect on the analysis is 

disproportionate.  Further analysis is required to better understand this. 

○ The ASD instrument appears more strongly affected by the rock type (gabbro 

versus granophyre) compared with the KM instrument.  It is not possible for 

the data or statistics to confirm why this is so, but the most likely cause is 

different illumination and different geometry of the light receptor. 

• The near infrared (NIR) spectral line data suggests some statistically significant 

changes.  The analysis of this is particularly strongly affected by the rock type- 

indeed the NIR data makes the differences between rock types glaringly 

apparent, suggesting that this factor should have been incorporated into the 

monitoring from early on.  Whilst it might be expected that different rock types 

give rise to significantly different spectral data, it is not so obvious that changes in 

the spectral data over time are similarly affected.  Our analysis has demonstrated 

that this is the case. 

Overall, this analysis extends the previous analyses through the additional data and 

through a trend based approach to modelling.  The analysis suggests that some 

changes may have occurred, but this finding remains inconclusive.   

Further analysis might shed some light on this.  In this regard it is worth considering 

what additional data may be available to explain the observations, such as the 

possible age of the individual petroglyphs, their orientation etc.  However any such 

analysis is likely to remain limited by the monitoring design. 
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Appendix A. ASD Spectral Plots 
Four arbitrarily selected spectra are presented in Figure 29 to Figure 32 below, for 

illustrative purposes, as displayed by the TSG program.  The first three figures show 

typical patterns for the measured points (both background and engraving).  In 

contrast, Figure 32 clearly illustrates an erroneous reading, and this point was 

excluded from the analysis as an outlier. 

 

Figure 29.  Spectral line for random selected point at site21, spot 6, point 6, and type 

background. 

 

Figure 30.  Spectral line for random selected point at site5, spot 3, point 19, and type 

engraving.  
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Figure 31.  Spectral line for random selected point at site 7, spot 1, point 22, and type 

engraving.  

 

Figure 32.  Spectral line for outlier point at site 5, spot 3, and type background.  
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Appendix B. Distribution of L*, a* and b* Values With 
the KM Instrument 

The boxplots in this Appendix show the distribution of L*, a* and b* values from the 

KM instrument for all sites and then for Yara and Control sites only.  These boxplots 

show the values for each of type, Control-Industry, Site and Year separately, rather 

than as the three way plots shown in the main report.  As a result, care must be taken 

when interpreting these boxplots, as apparent differences in one variable (e.g. time) 

may be caused by a difference in another variable (e.g. that control site data is not 

available for 2017, but is included for all other years). 

B.1 All Sites 

 

Figure 33.  Distribution of L* observations made with the KM instrument, all sites. 
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Figure 34.  Distribution of a* observations made with the KM instrument, all sites. 

 

Figure 35.  Distribution of b* observations made with the KM instrument, all sites. 
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B.2 Yara and Control Sites Only 

 

Figure 36.  Distribution of L* observations made with the KM instrument, Yara and 

Control sites only. 

 

Figure 37.  Distribution of a* observations made with the KM instrument, Yara and Control 

sites only. 
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Figure 38.  Distribution of b* observations made with the KM instrument, Yara and 

Control sites only. 
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Appendix C. Distribution of L*, a*, b* Values with the 
ASD Instrument 

The boxplots in this Appendix show the distribution of L*, a* and b* values from the 

ASD instrument for all sites and then for Yara and Control sites only.  These boxplots 

show the values for each of type, Control-Industry, Site and Year separately, rather 

than as the three way plots shown in the main report.  As a result, care must be taken 

when interpreting these boxplots, as apparent differences in one variable (e.g. time) 

may be caused by a difference in another variable (e.g. that control site data is not 

available for 2017, but is included for all other years). 

These boxplots exclude the 2004 data as it was excluded from the analysis for reasons 

outlined in Section 1.4. 

C.1 All Sites, Years 2005 to 2017 

 

Figure 39.  Distribution of L* observations made with the ASD instrument, all sites. 
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Figure 40.  Distribution of a* observations made with the ASD instrument, all sites. 

 

Figure 41.  Distribution of b* observations made with the ASD instrument, all sites. 
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C.2 Yara and Control Sites Only, Years 2005-2017 

 
Figure 42.  Distribution of L* observations made with the ASD instrument, Yara and 

Control sites only. 

 
Figure 43.  Distribution of a* observations made with the ASD instrument, Yara and 

Control sites only. 
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Figure 44.  Distribution of b* observations made with the ASD instrument, Yara and 

Control sites only. 

 

10

15

20

25

Bkg
(N=4091)

Eng
(N=4095)

Type

b

10

15

20

25

Control
(N=2313)

Industry
(N=5873)

Control - Industry

b

10

15

20

25

1
(N=1093)

2
(N=1220)

5
(N=1332)

6
(N=1314)

7
(N=1299)

21
(N=635)

22
(N=633)

23
(N=660)

Site

b

10

15

20

25

20
05

(N
=3

09
)

20
06

(N
=2

10
)

20
07

(N
=3

00
)

20
08

(N
=3

08
)

20
09

(N
=2

89
)

20
10

(N
=3

24
)

20
11

(N
=3

25
)

20
12

(N
=3

57
)

20
13

(N
=1

00
0)

20
14

(N
=7

04
)

20
15

(N
=1

49
3)

20
16

(N
=1

41
9)

20
17

(N
=1

14
8)

Year

b



DATA ANALYSIS AUSTRALIA PTY LTD 
  

  

DWER/3 ~ Page 44 ~ October 2018 
(Ref: Q:\job\dwer3\reports\dwer3_report_20181003.docx) 

Appendix D. Distribution of Spectral Line Values with 
the ASD Instrument 

The boxplots in this Appendix show the distribution of the spectral line values from 

the ASD instrument for all sites and then for Yara and Control sites only.  These 

boxplots show the values for each of type, Control-Industry, Site and Year separately, 

rather than as the three way plots shown in the main report.  As a result, care must 

be taken when interpreting these boxplots, as apparent differences in one variable 

(e.g. time) may be caused by a difference in another variable (e.g. that control site 

data is not available for 2017, but is included for all other years). 

D.1 All Sites, Years 2005 to 2017 

 

Figure 45.  Distribution of depth at 900 nm made with the ASD instrument, all sites. 
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Figure 46.  Distribution of depth of chlorite made with the ASD instrument, all sites. 

 

Figure 47.  Distribution of depth of gibbsite made with the ASD instrument, all sites. 
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Figure 48. Distribution of depth of kaolinite made with the ASD instrument, all sites. 

 

Figure 49. Distribution of minimum wavelength at 900 nm made with the ASD instrument, 

all sites. 
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D.2 Yara and Control Sites Only, Years 2005-2017 

 

Figure 50.  Distribution of depth at 900 nm made with the ASD instrument, Yara and 

Control sites only. 

 

Figure 51.  Distribution of depth of chlorite made with the ASD instrument, Yara and 

Control sites only. 
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Figure 52.  Distribution of depth of gibbsite made with the ASD instrument, Yara and 

Control sites only. 

 

Figure 53.  Distribution of depth of kaolinite made with the ASD instrument, Yara and 

Control sites only. 
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Figure 54.  Distribution of minimum wavelength at 900 nm made with the ASD 

instrument, Yara and Control sites only. 
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Appendix E. Comparison between Instruments 
These figures show the trends of the L*, a* and b* values in the background and 

engravings over the period 2004-2017, split by KM and ASD.  Each figure covers one 

site.  Note that sites 1, 2, 4, and 8 were not visited in 2017.  
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Figure 55.  Individual readings and average �∗, �∗, �∗ values for Site 1.  Black lines and 

points represent the KM Spectrophotometer and red lines and points the ASD 

spectrometer.  Engraving points are represented by the letter E (and the corresponding spot 

number) for individual readings and the dashed lines for their averages; and background 

points are represented by the letter B (and the corresponding spot number) for their 

individual readings and the solid lines for their averages. 
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Figure 56.  Individual readings and average �∗, �∗, �∗ values for Site 2.  Black lines and 

points represent the KM Spectrophotometer, and red lines and points the ASD 

spectrometer.  Engraving points are represented by the letter E (and the corresponding spot 

number) for individual readings and the dashed lines for their averages; and background 

points are represented by the letter B (and the corresponding spot number) for their 

individual readings and the solid lines for their averages. 
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Figure 57.  Individual readings and average �∗, �∗, �∗ values for Site 4.  Black lines and 

points represent the KM Spectrophotometer, and red lines and points the ASD 

spectrometer.  Engraving points are represented by the letter E (and the corresponding spot 

number) for individual readings and the dashed lines for their averages; and background 

points are represented by the letter B (and the corresponding spot number) for their 

individual readings and the solid lines for their averages. 
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Figure 58.  Individual readings and average �∗, �∗, �∗ values for Site 5.  Black lines and 

points represent the KM Spectrophotometer, and red lines and points the ASD 

spectrometer.  Engraving points are represented by the letter E (and the corresponding spot 

number) for individual readings and the dashed lines for their averages; and background 

points are represented by the letter B (and the corresponding spot number) for their 

individual readings and the solid lines for their averages. 
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Figure 59.  Individual readings and average �∗, �∗, �∗ values for Site 6.  Black lines and 

points represent the KM Spectrophotometer, and red lines and points the ASD 

spectrometer.  Engraving points are represented by the letter E (and the corresponding spot 

number) for individual readings and the dashed lines for their averages; and background 

points are represented by the letter B (and the corresponding spot number) for their 

individual readings and the solid lines for their averages. 
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Figure 60.  Individual readings and average �∗, �∗, �∗ values for Site 7.  Black lines and 

points represent the KM Spectrophotometer, and red lines and points the ASD 

spectrometer.  Engraving points are represented by the letter E (and the corresponding spot 

number) for individual readings and the dashed lines for their averages; and background 

points are represented by the letter B (and the corresponding spot number) for their 

individual readings and the solid lines for their averages. 
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Figure 61.  Individual readings and average �∗, �∗, �∗ values for Site 8.  Black lines and 

points represent the KM Spectrophotometer, and red lines and points the ASD 

spectrometer.  Engraving points are represented by the letter E (and the corresponding spot 

number) for individual readings and the dashed lines for their averages; and background 

points are represented by the letter B (and the corresponding spot number) for their 

individual readings and the solid lines for their averages. 
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Figure 62.  Individual readings and average �∗, �∗, �∗ values for Site 21.  Black lines and 

points represent the KM Spectrophotometer, and red lines and points the ASD 

spectrometer.  Engraving points are represented by the letter E (and the corresponding spot 

number) for individual readings and the dashed lines for their averages; and background 

points are represented by the letter B (and the corresponding spot number) for their 

individual readings and the solid lines for their averages. 
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Figure 63.  Individual readings and average �∗, �∗, �∗ values for Site 22.  Black lines and 

points represent the KM Spectrophotometer, and red lines and points the ASD 

spectrometer.  Engraving points are represented by the letter E (and the corresponding spot 

number) for individual readings and the dashed lines for their averages; and background 

points are represented by the letter B (and the corresponding spot number) for their 

individual readings and the solid lines for their averages. 
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Figure 64.  Individual readings and average �∗, �∗, �∗ values for Site 23.  Black lines and 

points represent the KM Spectrophotometer, and red lines and points the ASD 

spectrometer.  Engraving points are represented by the letter E (and the corresponding spot 

number) for individual readings and the dashed lines for their averages; and background 

points are represented by the letter B (and the corresponding spot number) for their 

individual readings and the solid lines for their averages. 
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Appendix F. Conversion of ASD Data using the TSG 
Program 

Read ASD data into TSG 

1. Stick with default options 
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Extract LAB  
First Go to File -> Settings then Colour Reporting, and choose “Lab(D50)” 

 

Then, Go to Edit -> New Scalar, and choose “scalar specific to core logging” 

1. 

 

2. It is necessary to change the default to “None (straight 

colour average)” 
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Calculation of Depth 900 nm 
Go to Edit -> New Scalar, and choose “a spectral Index from an attribute of a fitted 

polynomial” 

1. 

 

2. 
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Calculation of Minimum Wavelength at 900 nm 
Go to Edit -> New Scalar, and choose “a spectral Index from an attribute of a fitted 

polynomial” 

1. 

 

2. 
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Calculation for Depth of Chlorite 
Go to Edit -> New Scalar, and choose “a spectral Index from an attribute of a fitted 

polynomial” 

1. 

 

2. 
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Calculation for Depth of Kaolinite 
Go to Edit -> New Scalar, and choose “a spectral Index from an attribute of a fitted 

polynomial” 

1. 

 

2. 
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Calculation for Depth of Gibbsite 
Go to Edit -> New Scalar, and choose “a spectral Index from an attribute of a fitted 

polynomial” 

1. 

 

2. 
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Appendix G. Fitted Models, Colour Data 
This appendix presents the summary R output for the fitted models. 

In each case, the model summaries for the full models are presented (i.e. estimates of 

coefficients, Standard Errors and t-values), followed by the log likelihood of the full 

model, the log likelihood of the reduced model and the corresponding Chi square 

statistic to assess the statistical significance of the key interaction terms.  

G.1 KM Data, All sites 

With rock type 

L* 

                                                   Estimate Std. Error     t value 

(Intercept)                                       30.210087   1.903777 15.86849770 

CIIndustry                                         2.971307   2.195714  1.35323028 

typeEng                                            7.238027   1.257804  5.75449371 

rockGranophyre                                     2.327795   2.686348  0.86652796 

poly(year, 2)1                                     3.600033  25.246136  0.14259740 

poly(year, 2)2                                    16.105279  23.229127  0.69332263 

CIIndustry:typeEng                                -4.007521   1.453805 -2.75657467 

CIIndustry:rockGranophyre                         -1.343889   3.024705 -0.44430417 

typeEng:rockGranophyre                             1.767721   1.774172  0.99636355 

CIIndustry:poly(year, 2)1                        -59.986837  29.042328 -2.06549687 

CIIndustry:poly(year, 2)2                         16.448689  25.810657  0.63728287 

typeEng:poly(year, 2)1                           -18.926011  30.042854 -0.62996715 

typeEng:poly(year, 2)2                             2.268917  27.761230  0.08172969 

rockGranophyre:poly(year, 2)1                    -40.962794  32.071275 -1.27724245 

rockGranophyre:poly(year, 2)2                    -23.969000  29.208812 -0.82060851 

CIIndustry:typeEng:rockGranophyre                 -1.624658   1.999735 -0.81243656 

CIIndustry:typeEng:poly(year, 2)1                 63.631959  36.419563  1.74719171 

CIIndustry:typeEng:poly(year, 2)2                -41.838825  32.556525 -1.28511338 

CIIndustry:rockGranophyre:poly(year, 2)1         107.673040  37.634711  2.86100349 

CIIndustry:rockGranophyre:poly(year, 2)2          -2.486874  33.594926 -0.07402529 

typeEng:rockGranophyre:poly(year, 2)1             -9.469588  40.880327 -0.23164168 

typeEng:rockGranophyre:poly(year, 2)2            -26.126622  37.292509 -0.70058634 

CIIndustry:typeEng:rockGranophyre:poly(year, 2)1 -58.388759  47.721543 -1.22353040 

CIIndustry:typeEng:rockGranophyre:poly(year, 2)2  64.226371  42.729977  1.50307523 

'log Lik.' -10758.61 (df=37) 

'log Lik.' -10762.69 (df=33) 

[1] "Interaction chi square 8.15133633706137" 

a* 

                                                    Estimate Std. Error    t value 

(Intercept)                                       10.0043650  0.7576654 13.2042002 

CIIndustry                                         1.3415413  0.8730021  1.5366989 

typeEng                                            1.6542508  1.5900846  1.0403540 

rockGranophyre                                     1.5476723  1.0666323  1.4509895 

poly(year, 2)1                                    -3.7401946 15.8380168 -0.2361530 

poly(year, 2)2                                    -4.2592922 14.5053069 -0.2936368 

CIIndustry:typeEng                                -1.7660334  1.8370905 -0.9613209 

CIIndustry:rockGranophyre                         -0.6049422  1.2016894 -0.5034098 

typeEng:rockGranophyre                            -4.1233374  2.2483225 -1.8339617 
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CIIndustry:poly(year, 2)1                        -61.7822190 18.2727590 -3.3811106 

CIIndustry:poly(year, 2)2                         35.7208927 16.0777706  2.2217566 

typeEng:poly(year, 2)1                            15.9667613 17.2456970  0.9258403 

typeEng:poly(year, 2)2                            26.3198874 15.8290094  1.6627628 

rockGranophyre:poly(year, 2)1                    -14.5782767 20.5779846 -0.7084404 

rockGranophyre:poly(year, 2)2                      5.4932409 18.6112949  0.2951563 

CIIndustry:typeEng:rockGranophyre                  5.7586459  2.5312075  2.2750588 

CIIndustry:typeEng:poly(year, 2)1                 40.4013388 21.2190407  1.9040134 

CIIndustry:typeEng:poly(year, 2)2                -42.9499326 18.7384904 -2.2920700 

CIIndustry:rockGranophyre:poly(year, 2)1          82.1513765 24.0492842  3.4159593 

CIIndustry:rockGranophyre:poly(year, 2)2         -30.3795315 21.3284448 -1.4243669 

typeEng:rockGranophyre:poly(year, 2)1             -7.8207594 24.0796814 -0.3247867 

typeEng:rockGranophyre:poly(year, 2)2            -34.7211158 21.8610461 -1.5882641 

CIIndustry:typeEng:rockGranophyre:poly(year, 2)1 -58.4789221 28.1021656 -2.0809401 

CIIndustry:typeEng:rockGranophyre:poly(year, 2)2  60.6083783 25.0039979  2.4239475 

'log Lik.' -6009.015 (df=37) 

'log Lik.' -6017.765 (df=33) 

[1] "Interaction chi square 17.5004142908001" 

b* 

                                                    Estimate Std. Error     t value 

(Intercept)                                       11.5712358  0.9339839 12.38911677 

CIIndustry                                         3.3417226  1.0777189  3.10073663 

typeEng                                            6.6845638  1.9842471  3.36881621 

rockGranophyre                                     3.8472030  1.3163406  2.92265012 

poly(year, 2)1                                    11.8537637 19.8529437  0.59707839 

poly(year, 2)2                                     9.5276317 18.1161489  0.52591927 

CIIndustry:typeEng                                -3.9662424  2.2919736 -1.73049223 

CIIndustry:rockGranophyre                         -2.7882835  1.4832128 -1.87989439 

typeEng:rockGranophyre                            -2.5649694  2.8042544 -0.91467072 

CIIndustry:poly(year, 2)1                        -62.1561040 23.5722677 -2.63683175 

CIIndustry:poly(year, 2)2                         34.5308748 20.7091959  1.66741746 

typeEng:poly(year, 2)1                            -0.2679065 24.9495381 -0.01073793 

typeEng:poly(year, 2)2                            37.1280690 22.9622778  1.61691577 

rockGranophyre:poly(year, 2)1                    -47.2864009 26.4046357 -1.79083709 

rockGranophyre:poly(year, 2)2                    -10.9532339 23.8461395 -0.45932944 

CIIndustry:typeEng:rockGranophyre                  3.6729244  3.1574465  1.16325784 

CIIndustry:typeEng:poly(year, 2)1                 53.0950812 30.2557578  1.75487527 

CIIndustry:typeEng:poly(year, 2)2                -61.9835003 26.8273405 -2.31046012 

CIIndustry:rockGranophyre:poly(year, 2)1         116.2691224 30.9022192  3.76248456 

CIIndustry:rockGranophyre:poly(year, 2)2         -23.1915801 27.3506130 -0.84793639 

typeEng:rockGranophyre:poly(year, 2)1              5.0208954 34.0634629  0.14739827 

typeEng:rockGranophyre:poly(year, 2)2            -55.5463247 30.9795908 -1.79299736 

CIIndustry:typeEng:rockGranophyre:poly(year, 2)1 -81.2213103 39.8108817 -2.04017863 

CIIndustry:typeEng:rockGranophyre:poly(year, 2)2  82.3441124 35.4794625  2.32089515 

'log Lik.' -8356.477 (df=37) 

'log Lik.' -8364.781 (df=33) 

[1] "Interaction chi square 16.6073040223782" 

                                                  Estimate Std. Error      t value 

(Intercept)                                  10.9273638100  1.0180758 10.733349952 

CIIndustry                                    3.3697168777  1.1905079  2.830486728 

typeEng                                       6.4733983082  1.8361331  3.525560412 

rockGranophyre                                4.4007618080  1.4397789  3.056553866 

trend_pre                                     0.1049091489  0.1655128  0.633843233 

trend_post                                   -0.1555141393  0.2074464 -0.749659555 

CIIndustry:typeEng                           -3.1249580605  2.1311629 -1.466315889 



DATA ANALYSIS AUSTRALIA PTY LTD 
 

 

  

DWER/3 ~ Page 70 ~ October 2018 
 (Ref: Q:\job\dwer3\reports\dwer3_report_20181003.docx) 

CIIndustry:rockGranophyre                    -3.6483488818  1.6323778 -2.234990557 

typeEng:rockGranophyre                       -2.0916891757  2.5966849 -0.805522900 

CIIndustry:trend_pre                         -0.1676136796  0.2224523 -0.753481440 

CIIndustry:trend_post                         0.1210176456  0.2340930  0.516963931 

typeEng:trend_pre                            -0.2123671439  0.1896230 -1.119943891 

typeEng:trend_post                            0.3563700138  0.2378668  1.498191322 

rockGranophyre:trend_pre                     -0.1710686141  0.2340834 -0.730801961 

rockGranophyre:trend_post                     0.1086761885  0.2934036  0.370398304 

CIIndustry:typeEng:rockGranophyre             2.9494725396  2.9312667  1.006210919 

CIIndustry:typeEng:trend_pre                  0.1820190557  0.2548933  0.714099037 

CIIndustry:typeEng:trend_post                -0.2885366850  0.2684781 -1.074712153 

CIIndustry:rockGranophyre:trend_pre           0.1081498705  0.2884787  0.374897264 

CIIndustry:rockGranophyre:trend_post          0.0225989526  0.3226662  0.070038188 

typeEng:rockGranophyre:trend_pre              0.1210799027  0.2681831  0.451482222 

typeEng:rockGranophyre:trend_post            -0.1924240242  0.3364019 -0.572006289 

CIIndustry:typeEng:rockGranophyre:trend_pre  -0.0009884714  0.3307600 -0.002988486 

CIIndustry:typeEng:rockGranophyre:trend_post  0.0897705461  0.3700293  0.242603901 

'log Lik.' -14447.9 (df=37) 

'log Lik.' -14448.94 (df=33) 

[1] "chi square 2.07420832435673" 

G.2 ASD Colour Data, all sites 

With rock type 

L* 

                                                   Estimate Std. Error     t value 

(Intercept)                                       30.210087   1.903777 15.86849770 

CIIndustry                                         2.971307   2.195714  1.35323028 

typeEng                                            7.238027   1.257804  5.75449371 

rockGranophyre                                     2.327795   2.686348  0.86652796 

poly(year, 2)1                                     3.600033  25.246136  0.14259740 

poly(year, 2)2                                    16.105279  23.229127  0.69332263 

CIIndustry:typeEng                                -4.007521   1.453805 -2.75657467 

CIIndustry:rockGranophyre                         -1.343889   3.024705 -0.44430417 

typeEng:rockGranophyre                             1.767721   1.774172  0.99636355 

CIIndustry:poly(year, 2)1                        -59.986837  29.042328 -2.06549687 

CIIndustry:poly(year, 2)2                         16.448689  25.810657  0.63728287 

typeEng:poly(year, 2)1                           -18.926011  30.042854 -0.62996715 

typeEng:poly(year, 2)2                             2.268917  27.761230  0.08172969 

rockGranophyre:poly(year, 2)1                    -40.962794  32.071275 -1.27724245 

rockGranophyre:poly(year, 2)2                    -23.969000  29.208812 -0.82060851 

CIIndustry:typeEng:rockGranophyre                 -1.624658   1.999735 -0.81243656 

CIIndustry:typeEng:poly(year, 2)1                 63.631959  36.419563  1.74719171 

CIIndustry:typeEng:poly(year, 2)2                -41.838825  32.556525 -1.28511338 

CIIndustry:rockGranophyre:poly(year, 2)1         107.673040  37.634711  2.86100349 

CIIndustry:rockGranophyre:poly(year, 2)2          -2.486874  33.594926 -0.07402529 

typeEng:rockGranophyre:poly(year, 2)1             -9.469588  40.880327 -0.23164168 

typeEng:rockGranophyre:poly(year, 2)2            -26.126622  37.292509 -0.70058634 

CIIndustry:typeEng:rockGranophyre:poly(year, 2)1 -58.388759  47.721543 -1.22353040 

CIIndustry:typeEng:rockGranophyre:poly(year, 2)2  64.226371  42.729977  1.50307523 

'log Lik.' -10758.61 (df=37) 

'log Lik.' -10762.69 (df=33) 

[1] "Interaction chi square 8.15133633706137" 
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a* 

                                                    Estimate Std. Error    t value 

(Intercept)                                       10.0043650  0.7576654 13.2042002 

CIIndustry                                         1.3415413  0.8730021  1.5366989 

typeEng                                            1.6542508  1.5900846  1.0403540 

rockGranophyre                                     1.5476723  1.0666323  1.4509895 

poly(year, 2)1                                    -3.7401946 15.8380168 -0.2361530 

poly(year, 2)2                                    -4.2592922 14.5053069 -0.2936368 

CIIndustry:typeEng                                -1.7660334  1.8370905 -0.9613209 

CIIndustry:rockGranophyre                         -0.6049422  1.2016894 -0.5034098 

typeEng:rockGranophyre                            -4.1233374  2.2483225 -1.8339617 

CIIndustry:poly(year, 2)1                        -61.7822190 18.2727590 -3.3811106 

CIIndustry:poly(year, 2)2                         35.7208927 16.0777706  2.2217566 

typeEng:poly(year, 2)1                            15.9667613 17.2456970  0.9258403 

typeEng:poly(year, 2)2                            26.3198874 15.8290094  1.6627628 

rockGranophyre:poly(year, 2)1                    -14.5782767 20.5779846 -0.7084404 

rockGranophyre:poly(year, 2)2                      5.4932409 18.6112949  0.2951563 

CIIndustry:typeEng:rockGranophyre                  5.7586459  2.5312075  2.2750588 

CIIndustry:typeEng:poly(year, 2)1                 40.4013388 21.2190407  1.9040134 

CIIndustry:typeEng:poly(year, 2)2                -42.9499326 18.7384904 -2.2920700 

CIIndustry:rockGranophyre:poly(year, 2)1          82.1513765 24.0492842  3.4159593 

CIIndustry:rockGranophyre:poly(year, 2)2         -30.3795315 21.3284448 -1.4243669 

typeEng:rockGranophyre:poly(year, 2)1             -7.8207594 24.0796814 -0.3247867 

typeEng:rockGranophyre:poly(year, 2)2            -34.7211158 21.8610461 -1.5882641 

CIIndustry:typeEng:rockGranophyre:poly(year, 2)1 -58.4789221 28.1021656 -2.0809401 

CIIndustry:typeEng:rockGranophyre:poly(year, 2)2  60.6083783 25.0039979  2.4239475 

'log Lik.' -6009.015 (df=37) 

'log Lik.' -6017.765 (df=33) 

[1] "Interaction chi square 17.5004142908001" 

b* 

                                                    Estimate Std. Error     t value 

(Intercept)                                       11.5712358  0.9339839 12.38911677 

CIIndustry                                         3.3417226  1.0777189  3.10073663 

typeEng                                            6.6845638  1.9842471  3.36881621 

rockGranophyre                                     3.8472030  1.3163406  2.92265012 

poly(year, 2)1                                    11.8537637 19.8529437  0.59707839 

poly(year, 2)2                                     9.5276317 18.1161489  0.52591927 

CIIndustry:typeEng                                -3.9662424  2.2919736 -1.73049223 

CIIndustry:rockGranophyre                         -2.7882835  1.4832128 -1.87989439 

typeEng:rockGranophyre                            -2.5649694  2.8042544 -0.91467072 

CIIndustry:poly(year, 2)1                        -62.1561040 23.5722677 -2.63683175 

CIIndustry:poly(year, 2)2                         34.5308748 20.7091959  1.66741746 

typeEng:poly(year, 2)1                            -0.2679065 24.9495381 -0.01073793 

typeEng:poly(year, 2)2                            37.1280690 22.9622778  1.61691577 

rockGranophyre:poly(year, 2)1                    -47.2864009 26.4046357 -1.79083709 

rockGranophyre:poly(year, 2)2                    -10.9532339 23.8461395 -0.45932944 

CIIndustry:typeEng:rockGranophyre                  3.6729244  3.1574465  1.16325784 

CIIndustry:typeEng:poly(year, 2)1                 53.0950812 30.2557578  1.75487527 

CIIndustry:typeEng:poly(year, 2)2                -61.9835003 26.8273405 -2.31046012 

CIIndustry:rockGranophyre:poly(year, 2)1         116.2691224 30.9022192  3.76248456 

CIIndustry:rockGranophyre:poly(year, 2)2         -23.1915801 27.3506130 -0.84793639 

typeEng:rockGranophyre:poly(year, 2)1              5.0208954 34.0634629  0.14739827 

typeEng:rockGranophyre:poly(year, 2)2            -55.5463247 30.9795908 -1.79299736 

CIIndustry:typeEng:rockGranophyre:poly(year, 2)1 -81.2213103 39.8108817 -2.04017863 

CIIndustry:typeEng:rockGranophyre:poly(year, 2)2  82.3441124 35.4794625  2.32089515 
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'log Lik.' -8356.477 (df=37) 

'log Lik.' -8364.781 (df=33) 

[1] "Interaction chi square 16.6073040223782" 

 

G.3 ASD Spectral Data, All sites 

Depth_900nm 

                                                     Estimate Std. Error     t value 

(Intercept)                                       0.090785921 0.02855949  3.17883571 

CIIndustry                                        0.027081362 0.03299496  0.82077260 

typeEng                                          -0.020263039 0.01664105 -1.21765375 

rockGranophyre                                   -0.018688813 0.04038523 -0.46276356 

poly(year, 2)1                                    0.044605649 0.04310631  1.03478227 

poly(year, 2)2                                   -0.013000254 0.04073797 -0.31911887 

CIIndustry:typeEng                               -0.008262382 0.01927433 -0.42867294 

CIIndustry:rockGranophyre                         0.025691867 0.04546808  0.56505286 

typeEng:rockGranophyre                           -0.021137838 0.02352255 -0.89862015 

CIIndustry:poly(year, 2)1                        -0.147424724 0.05467947 -2.69616226 

CIIndustry:poly(year, 2)2                         0.040450234 0.04839107  0.83590286 

typeEng:poly(year, 2)1                           -0.015587134 0.06049694 -0.25765162 

typeEng:poly(year, 2)2                            0.009386423 0.05730493  0.16379783 

rockGranophyre:poly(year, 2)1                     0.112492103 0.05907888  1.90410012 

rockGranophyre:poly(year, 2)2                     0.156280909 0.05577867  2.80180425 

CIIndustry:typeEng:rockGranophyre                 0.031906098 0.02652631  1.20280949 

CIIndustry:typeEng:poly(year, 2)1                 0.146127675 0.07657138  1.90838507 

CIIndustry:typeEng:poly(year, 2)2                -0.010432104 0.06821876 -0.15292135 

CIIndustry:rockGranophyre:poly(year, 2)1          0.044196957 0.07096553  0.62279469 

CIIndustry:rockGranophyre:poly(year, 2)2         -0.170171505 0.06415136 -2.65265614 

typeEng:rockGranophyre:poly(year, 2)1            -0.123752270 0.08330474 -1.48553699 

typeEng:rockGranophyre:poly(year, 2)2            -0.188258181 0.07885206 -2.38748584 

CIIndustry:typeEng:rockGranophyre:poly(year, 2)1 -0.007059260 0.09971973 -0.07079101 

CIIndustry:typeEng:rockGranophyre:poly(year, 2)2  0.204801714 0.09062587  2.25985932 

'log Lik.' 2117.67 (df=34) 

'log Lik.' 2110.17 (df=30) 

[1] "Interaction chi square 15.0012693918434" 

Min_wavelength_900nm band 

                                                   Estimate Std. Error     t value 

(Intercept)                                      896.356642   3.145716 284.9451900 

CIIndustry                                        -2.621146   3.637130  -0.7206633 

typeEng                                           -6.890060   1.101964  -6.2525248 

rockGranophyre                                     2.604014   4.445201   0.5858033 

poly(year, 2)1                                    -4.310642   9.292459  -0.4638860 

poly(year, 2)2                                     4.318825   8.877108   0.4865127 

CIIndustry:typeEng                                 4.071034   1.309043   3.1099314 

CIIndustry:rockGranophyre                         -2.218129   5.008828  -0.4428439 

typeEng:rockGranophyre                            10.395743   1.556339   6.6796145 

CIIndustry:poly(year, 2)1                         24.603165  11.333875   2.1707637 

CIIndustry:poly(year, 2)2                        -14.153542  10.177526  -1.3906663 

typeEng:poly(year, 2)1                           -14.450339  12.322597  -1.1726699 

typeEng:poly(year, 2)2                           -20.418887  11.852303  -1.7227780 

rockGranophyre:poly(year, 2)1                     -6.372725  12.327620  -0.5169469 

rockGranophyre:poly(year, 2)2                      3.987040  11.781349   0.3384196 

CIIndustry:typeEng:rockGranophyre                 -9.529605   1.781035  -5.3505991 
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CIIndustry:typeEng:poly(year, 2)1                  3.983401  15.655265   0.2544448 

CIIndustry:typeEng:poly(year, 2)2                 22.395557  14.198405   1.5773291 

CIIndustry:rockGranophyre:poly(year, 2)1         -13.560495  14.759853  -0.9187419 

CIIndustry:rockGranophyre:poly(year, 2)2           1.714607  13.540505   0.1266280 

typeEng:rockGranophyre:poly(year, 2)1             39.099496  17.303183   2.2596708 

typeEng:rockGranophyre:poly(year, 2)2             44.649881  16.645125   2.6824599 

CIIndustry:typeEng:rockGranophyre:poly(year, 2)1 -30.905727  20.573890  -1.5021820 

CIIndustry:typeEng:rockGranophyre:poly(year, 2)2 -44.326259  19.086530  -2.3223843 

'log Lik.' -1457.461 (df=34) 

'log Lik.' -1461.393 (df=30) 

[1] "Interaction chi square 7.86393818858051" 

Depth kaolinite 

                                                      Estimate  Std. Error     t value 

(Intercept)                                       0.0617437735 0.011829190  5.21961139 

CIIndustry                                       -0.0034102481 0.013665335 -0.24955467 

typeEng                                          -0.0177570932 0.004468359 -3.97396341 

rockGranophyre                                   -0.0237617306 0.016725529 -1.42068636 

poly(year, 2)1                                   -0.0393978576 0.018939379 -2.08020855 

poly(year, 2)2                                    0.0060451380 0.017929496  0.33716162 

CIIndustry:typeEng                               -0.0059204797 0.005204406 -1.13758982 

CIIndustry:rockGranophyre                         0.0029627008 0.018830964  0.15733134 

typeEng:rockGranophyre                            0.0076572086 0.006319139  1.21174876 

CIIndustry:poly(year, 2)1                        -0.0726188022 0.023392408 -3.10437477 

CIIndustry:poly(year, 2)2                        -0.0085531804 0.020767115 -0.41186176 

typeEng:poly(year, 2)1                            0.0241856499 0.025245444  0.95802039 

typeEng:poly(year, 2)2                           -0.0001791123 0.023908194 -0.00749167 

rockGranophyre:poly(year, 2)1                     0.0634862578 0.025279288  2.51139418 

rockGranophyre:poly(year, 2)2                    -0.0039976900 0.023907196 -0.16721702 

CIIndustry:typeEng:rockGranophyre                 0.0103881874 0.007146583  1.45358792 

CIIndustry:typeEng:poly(year, 2)1                 0.1024721760 0.032536896  3.14941462 

CIIndustry:typeEng:poly(year, 2)2                -0.0030286051 0.028799619 -0.10516129 

CIIndustry:rockGranophyre:poly(year, 2)1          0.0317486965 0.030351210  1.04604385 

CIIndustry:rockGranophyre:poly(year, 2)2          0.0031300867 0.027499851  0.11382195 

typeEng:rockGranophyre:poly(year, 2)1            -0.0829418257 0.035693564 -2.32371937 

typeEng:rockGranophyre:poly(year, 2)2            -0.0303985725 0.033802746 -0.89929298 

CIIndustry:typeEng:rockGranophyre:poly(year, 2)1 -0.0489443869 0.042653930 -1.14747662 

CIIndustry:typeEng:rockGranophyre:poly(year, 2)2  0.0373995894 0.038760634  0.96488590 

'log Lik.' 2691.608 (df=34) 

'log Lik.' 2684.42 (df=30) 

[1] "Interaction chi square 14.3767835114886" 

Depth chlorite 

                                       Estimate  Std. Error     t value 

(Intercept)                        0.0578809423 0.021513559  2.69044009 

CIIndustry                         0.0110971212 0.024852523  0.44651890 

typeEng                            0.0421695563 0.009718044  4.33930488 

poly(year, 2)1                    -0.0007448925 0.024790599 -0.03004738 

poly(year, 2)2                    -0.0482653544 0.022472637 -2.14773883 

CIIndustry:typeEng                -0.0276513501 0.011280808 -2.45118526 

CIIndustry:poly(year, 2)1         -0.0543524024 0.030869451 -1.76071815 

CIIndustry:poly(year, 2)2          0.0435640664 0.026695099  1.63191250 

typeEng:poly(year, 2)1             0.0058092825 0.033839967  0.17166927 

typeEng:poly(year, 2)2             0.0557726358 0.030831977  1.80892180 

CIIndustry:typeEng:poly(year, 2)1  0.0498422540 0.042562676  1.17103198 

CIIndustry:typeEng:poly(year, 2)2 -0.0714081039 0.037097863 -1.92485761 
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'log Lik.' 738.2996 (df=22) 

'log Lik.' 735.0513 (df=20) 

[1] "Interaction chi square 6.49650202861744" 

Depth gibbsite (square root) 

                                                      Estimate  Std. Error      t value 

(Intercept)                                       2.414272e-03 0.004833201  0.499518128 

CIIndustry                                        1.278929e-04 0.005584087  0.022903098 

typeEng                                           2.290187e-03 0.004060619  0.563999564 

rockGranophyre                                   -5.621336e-05 0.006835179 -0.008224124 

poly(year, 2)1                                    1.462771e-02 0.006798918  2.151476497 

poly(year, 2)2                                   -2.213167e-04 0.006472412 -0.034193859 

CIIndustry:typeEng                               -1.644866e-03 0.004694527 -0.350379494 

CIIndustry:rockGranophyre                         1.400141e-03 0.007695221  0.181949459 

typeEng:rockGranophyre                           -1.864985e-03 0.005741224 -0.324841024 

CIIndustry:poly(year, 2)1                         1.219549e-04 0.008835933  0.013802153 

CIIndustry:poly(year, 2)2                         4.470926e-03 0.007805496  0.572791990 

typeEng:poly(year, 2)1                            1.403783e-02 0.009796862  1.432890165 

typeEng:poly(year, 2)2                            8.811590e-03 0.009406563  0.936749170 

rockGranophyre:poly(year, 2)1                    -1.100333e-02 0.009615108 -1.144378875 

rockGranophyre:poly(year, 2)2                     2.048741e-02 0.009153371  2.238236761 

CIIndustry:typeEng:rockGranophyre                -2.069044e-03 0.006466772 -0.319950065 

CIIndustry:typeEng:poly(year, 2)1                -9.308121e-03 0.012293080 -0.757183781 

CIIndustry:typeEng:poly(year, 2)2                -8.291736e-03 0.011150653 -0.743609900 

CIIndustry:rockGranophyre:poly(year, 2)1         -6.202244e-03 0.011549322 -0.537022388 

CIIndustry:rockGranophyre:poly(year, 2)2         -2.694126e-02 0.010503280 -2.565033445 

typeEng:rockGranophyre:poly(year, 2)1            -2.176132e-02 0.013460713 -1.616654537 

typeEng:rockGranophyre:poly(year, 2)2            -3.370895e-02 0.012927796 -2.607478286 

CIIndustry:typeEng:rockGranophyre:poly(year, 2)1  2.368537e-02 0.016063422  1.474490792 

CIIndustry:typeEng:rockGranophyre:poly(year, 2)2  3.232471e-02 0.014852561  2.176372823 

'log Lik.' 3384.074 (df=34) 

'log Lik.' 3380.476 (df=30) 

[1] "Interaction chi square 7.19586731780873" 
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Appendix H. Interaction Plots,  

H.1 KM Colour Data 

 

Figure 65.  Interaction plot for full KM data, L*. 

 

Figure 66.  Interaction plot for full KM data, a*. 
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Figure 67.  Interaction plot for full KM data, b*. 

 

Figure 68.  Interaction plot for Yara KM data, L*. 
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Figure 69.  Interaction plot for Yara KM data, a*. 

 

Figure 70.  Interaction plot for Yara KM data, b*. 
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H.2 ASD Colour Data 

 

Figure 71.  Interaction plot for full ASD data, L*. 

 

Figure 72.  Interaction plot for full ASD data, a*. 
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Figure 73.  Interaction plot for full ASD data, b*. 

 

Figure 74.  Interaction plot for Yara ASD data, L*. 
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Figure 75.  Interaction plot for Yara ASD data, a*. 

 

Figure 76.  Interaction plot for Yara ASD data, b*. 
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H.3 ASD Spectral Data 

 

Figure 77.  Interaction plot for full ASD data, depth 900nm band. 

 

Figure 78.  Interaction plot for full ASD data, minimum wavelength, 900nm band. 
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Figure 79.  Interaction plot for full ASD data, depth kaolinite band. 

 

Figure 80.  Interaction plot for full ASD data, depth chlorite band (gabbro sites only). 
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Figure 81.  Interaction plot for full ASD data, depth gibbsite band (logarithm). 

 

Figure 82.  Interaction plot for Yara ASD data, depth 900nm band. 
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Figure 83.  Interaction plot for Yara ASD data, minimum wavelength, 900nm band. 

 

Figure 84.  Interaction plot for Yara ASD data, depth kaolinite band. 
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Figure 85.  Interaction plot for Yara ASD data, depth chlorite band (gabbro sites only). 

 

Figure 86.  Interaction plot for Yara ASD data, depth gibbsite band (logarithm). 
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